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Introduction
SpecSurf is a unique platform independent spectroscopic information system. It combines the
most frequently used spectroscopic techniques in an easy-to-use client-server architecture.
SpecSurf is designed for groups of people working together sharing databases, being
connected by a network.
SpecSurf is a new Java based applet which runs inside a web browser and offers all
necessary tools for structure drawing and import of experimental spectra. Using your
Netscape or Microsoft Internet Explorer browser and SpecSurf you can access the world's
largest spectra collection. SpecInfo and its more than 660,000 spectra is available on the
Internet. Use the browser for data display, spectrum similarity searches, substructure
searches or NMR shift prediction. The easy-to-use client offers spectra similarity searches for
all methods, substructure searches, name, MW and formula searches as well as precise NMR
shift prediction for various nuclei. Search results can be compared with experimental spectra
and printed by using a report generator.
SpecSurf delivers maximum efficiency for structure elucidation and structure identification.
The platform independent SpecInfo client SpecSurf includes the powerful Structure Editor
tool. Create a structure and within seconds you can predict NMR spectra for candidate
structures based on well-established rules. The predicted spectra of the new compounds will
be compared with database signal assignments. An easy-to-use Hitlist displays link hits to the
SpecSurf Result Zone. Any query, a spectrum search, a property search or a structure search
results in such a list of hits. Select hits by a left mouse-button click.
The software allows MOL-file format suitable for the import of structures as well as
spectrum/data import from JCAMP-DX format.
 

Search

Structure Searching

� Searching across different databases connectivity can be achieved using Intranet,
Internet or a remote modem/ISDN access from anywhere in the world.

� Searching for chemical structures
� Quick chemical substructure searching

 

Spectral Searching

� Searching across different databases
� Searching for the most important NMR nuclei
� Searching for MS, UV, IR, Raman

 

General Searching

� Searching across different databases
� Wildcard search on all entries of the Search Pattern, including chemical names,

formulas, molecular weight, or Original Numbers (ID).
 

The Workspace
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SpecSurf Workspace
The Workspace is what you see on your screen - the Title Bar, Menu Bar, Query as well as
Result area, Hitlist and Status Log area. The workplace also includes elements such as menu
commands, dialog boxes, and windows.
The Menu Bar contains a list of menus. A menu contains a list of related commands or
functions. Thus, the Search menu contains the standard functions for general search,
whereas the commands of the Settings menu help you to setup your favorite preferences and
to customize the software.
The Query as well as the Result area is divided into three main parts. Spectra are displayed
on the left side whereas structures are located in the middle. The table on the right contains
additional information about how many and what kind of objects are inside a folder.

Type Type of spectrum: IR, 13C, …
St Structure

Search results are displayed in the Hitlist. By default the first entry of a hitlist will automatically
displayed in the Result area. When moving the pointer over a result and pressing a mouse
button a connection to the SpecInfo server will be established again and the content of this
folder will be displayed.
 
The Folder principle
Data storage
Within a SpecInfo database information are stored in so-called "Folders". A folder consists of
objects such as spectra, structures and property information. Any folder may contain a
number of different spectra and structures even of the same type. A folder may contain the
NMR spectra of the same compound acquired using different solvents or observation
frequencies. All data is stored unmodified, the resolution, the number of data points or any
other property of a spectrum is not changed.
The advantage of this concept is to store all relevant information of a compound, a set of
compounds, a measurement or even a series of measurements in one folder.
All primary objects in a folder are on the same hierarchical level. There are no objects on a
higher level - but there are some interdependencies possible. For example, spectra can be
assigned to a certain structure within the folder, or vice versa different structures could be
connected to one spectrum (if e.g. you have measured a 13C-NMR spectrum of a mixture of
compounds). Another type of dependency between a structure and a NMR spectrum
(whatever type) is obtained if peaks of the spectrum are assigned to the corresponding atoms
in the structure.
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The stored information objects generally consist of several parts:
The structure and spectra information, which is given as connection tables and full or peak
spectra, respectively is complemented by textual information (notes) describing e.g. the
source, measure date, literature references, the kind of the experiment etc of the chemical
compound and/or spectra.
 

Dialogs
The user communicates with the software via dialogs. You can control the functionality of
commands by entering or modifying the parameters or values in the respective dialog. The
message dialogs display additional information, warnings, or messages concerning the
respective task.

Zoom
Zoom in/out a structure
Controls how large or small the current structure appears on the screen.
Pressing the Shift key and moving the mouse up or down moves a structure to the front or to
the rear.
 
Zoom in/out a spectrum
Controls how large or small the current spectrum appears on the screen.
To zoom in/out a part of a spectrum, move the pointer in the window containing the respective
spectrum. Press the left mouse button and drag a frame to the desired size. Releasing the
mouse button fixes the size of the frame and allows moving it to the desired zoom area.
Another left mouse-click zooms framed area to full window size. Double-click the right mouse
button to switch back to your previous view.
 

Security
SpecSurf uses JavaScript, which supports importing datasets. When JavaScript is active, the
upload process is more convenient, the browse window is resized to a small window and
shifted to the foreground. Since JavaScript is not necessarily required, you can disable it.
Java Sandbox
As an unsigned Java applet, SpecSurf does not have any access to the file system of your
computer.
When importing files from your hard disk, SpecSurf opens a window of your web browser,
which enables you to select a file or invoke a path and transfer this file to the web server
hosting your SpecSurf installation. This web server sends the file back to SpecSurf on your
computer. So SpecSurf can only get any knowledge about the data you intentionally select for
this purpose.
Another Java applet restriction for your security should be mentioned: SpecSurf cannot
contact any host different from the host it has been downloaded from.
 
SSL
When you start SpecSurf using https (SSL, this is an optional product), all data transfer
between your computer and SpecSurf's web server is encrypted.
 
Cookies
A future release of SpecSurf will use cookies to save your settings. If you do not accept these
cookies or your firewall filters cookies, your next SpecSurf session will start with default
settings. Other functionality is not affected.



6

 

Tutorial

Create a spectrum
If there is no spectrum in the Query spectrum area you can easily create hetero NMR or mass
spectra of your own. From the Edit menu select Peaklist. The Peaklist editor diaolg opens

In case the Query area contains a peak spectrum the table contains data. If you want to enter
new values click the New button to clear its contents. Select the method of your choice and
enter X- and Y-values in the edit boxes below the table. Click Add Row to transfer the values
into the table.
For a later change of any cell value double click the cell, enter a new value and finish the
change by pressing "Return". Click OK to leave the dialog. Your "new" spectrum will be
displayed in the spectrum query area. You can use this spectrum for a search in all
databases.
 

Using the Search Spectrum
command:
Import a spectrum from your local source or create a special one from publication data with
the Edit/Peaklist command.
Create a spectrum manually.
In this example the search was performed with a manually created 13C NMR spectrum with
two signals at 10 and 30 ppm.
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Start structure search
Open the Spectrum command of the Search menu. A connection to the SpecInfo Server is
established. This will take a moment. You receive a folder hitlist shown in the Hitlist area with
a ranking, quality and further information.

Ranking and Quality affect the search remarkable. You can change the Quality value in the
Settings/Databases/Set selection/Searches dialog.
The higher a quality value in the folder hitlist the better the match to the spectrum. The first
dataset of this list is automatically displayed in the Result Zone.
If nothing meets the search the message "No hits found" will be displayed in the status line.
 

Draw a new structure
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The Structure Editor extensively supports the generation and processing of single chemical
structures. It provides a wide range of features, which help you to draw accurate, chemically
significant structures quickly and intuitively. Its functionality is optimized for the fast creation of
even most complex chemical structures.

1. From the Structure menu select New structure. After a few seconds an empty
drawing window appears.

2. By default, the compass draw mode is active.

3. Move the pointer into the window. Clicking the left mouse button in an empty area
creates a circle of points around a carbon atom. It is also possible to click on an
already displayed atom; in this case, this particular atom will form the center of the
circle. The points constituting the circle represent the most common angles of
chemical structures.

4. Dragging the mouse draws molecular chains of any required length.

5. Adding a ring is quite easy. Simply move the pointer over the terminated bond, but
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don’t press the mouse button. The color of the bond changes to blue and a
rectangular hit box appears. Now press the „6“ key on the keyboard. Automatically a
six-membered ring is attached to the selected bond.

6. You can convert this aliphatic ring into an aromatic one by simply moving the pointer
into the ring. Press the left mouse button to execute the command.

7. Inserting heteroatoms is simple too. Select the carbon atom which you would like to
replace by pressing the left mouse button and then enter e.g. „N“ to substitute the
carbon by the nitrogen sign. As you can see from the screenshot the structure editor
offers additional information like formula and molecular weight.

8. After finishing your drawing select Transfer from the File menu to transfer the
structure into SpecSurf
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Using the Database based
prediction command

1. Drawn 2-Chloro-toluene using the internal Structure Editor.

2. Click Settings/Databases/Predictions to select one or more databases.
3. On the Predict menu, click Database based and select one of the given elements

from the list.

4.  A connection to the SpecInfo Server is established. The structure, displayed in the
Query Structure Zone, is sent to the server.

5. As a result you will receive a predicted spectrum in the Spectrum Result zone.
6. Activate the Select mode inside the Result area. When pointing with the mouse on an

atom, the respective peak is highlighted. When pointing with the cursor on a peak, the
respective atom or atoms is/are highlighted.

 

Using the Rule based prediction
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command
1. Drawn 2-Chloro-toluene using the internal Structure Editor.

2. Click Settings/Databases/Predictions to select one or more databases.
3. On the Predict menu, click Rule based and select 13C or 1H from the list.

4. A connection to the SpecInfo Server is established. The structure, displayed in the
Query Structure Zone, is sent to the server.

5. As a result you will receive a predicted spectrum in the Spectrum Result zone.
6. Activate the Select mode inside the Result area. When pointing with the mouse on an

atom, the respective peak is highlighted. When pointing with the cursor on a peak, the
respective atom or atoms is/are highlighted.

Using the Search Structure
command

1. Import a previously drawn structure or create a new one using the internal Structure
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Editor. As you can see the structure will be located in the structure query area

2. From the Settings menu select Databases/Searches and select one or more
databases.

3. Click Search/Structure to start the query. A connection to the SpecInfo server is
established and the structure, located in the Query Structure Zone, is sent to the
server.

4. After a few seconds you receive a hitlist and the first dataset of this list will be
displayed automatically in the result area. The table on the right hand of the result
area gives you information about all ojects in the transferred folder. In our example
the folder contains a 13C NMR spectrum with an assigned structue.

 
If nothing meets a search the message "No hits found" will be displayed in the status line.

Substructure search
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Important remarks:
The positions where substitution is allowed in the search fragments are identified by

a) "?“ (question mark)
A "?“ will be interpreted as „any atom exept hydrogen“.

b) "A“ (any atom)
An "A“ will be interpreted as „any atom including hydrogen“.

a) Question mark search
1. Import a previously drawn structure or create a new one using the internal Structure

Editor.
2. To modify any structure to define substitution positions with an explicit question mark

select Edit/Structure. After the editor was opened draw the follwoing structure

3. Move the pointer over the carbon atom as indicated in the screen shot

4. Replace the carbon symbol by typing the "?". Your are free to replace more than one
carbon atom with the "?" and start a substructure search.

5. From the File menu select Transfer to transfer the structure to the SpecSurf query
area.

6. From the Settings menu select Databases/Searches and select one or more
databases.

7. Click Search/Structure to start the query. A connection to the SpecInfo server is
established and the structure, located in the query structure area, is sent to the
server.

8. After a few seconds you receive a hitlist (14 hits) and the first dataset of this list will
be displayed automatically in the result area. The table on the right hand of the result
area gives you information about all ojects in the transferred folder. In our example
the folder Cyclohexanol, 2-methyl- contains two objects, an IR spectrum and a
structure.
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b) Any Atom search

1. Import a previously drawn structure or create a new one using the internal Structure
Editor.

2. To modify any structure to define substitution positions with an explicit question mark
select Edit/Structure. After the editor was opened draw the follwoing structure

3. Move the pointer over the carbon atom as indicated in the screen shot

4. Replace the carbon symbol by typing the "A". Your are free to replace more than one
carbon atom with the "A" and start a substructure search.
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5. From the File menu select Transfer to transfer the structure to the SpecSurf query
area.

6. From the Settings menu select Databases/Searches and select one or more
databases.

7. Click Search/Structure to start the query. A connection to the SpecInfo server is
established and the structure, located in the query structure area, is sent to the
server.

8. After a few seconds you receive a hitlist (16 hits) and the first dataset of this list will
be displayed automatically in the result area. The table on the right hand of the result
area gives you information about all ojects in the transferred folder. In our example
the folder Cyclohexanol contains four objects, two 13C NMR spectra, one 17O NMR
spectrum and a structure.

 
If nothing meets a search the message "No hits found" will be displayed in the status line.
 

Note Field search
An overview
Another quick way to find information in SpecInfo is through a Notes search. The Notes
search is a very easy to handle but powerful tool for data retrieval. This function allows you to
search every folder in a database for a particular string. It is different from the object search
because note fields may contain keywords or other data. The Notes search finds only folders
containing the string you are looking for. It uses the predefined fields in the databases dealing
with the most frequently used properties of spectra and structures such as:
� compound name
� formula
� molecular weight.

 

Compound Name

Search Text Comment Result (example)
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(example)
Benzene,
Cyclohexane

Searches for full names. Benzene, Cyclohexane

Benz* Searches for partial names. Wildcard
for an unlimited number of characters
is * „asterisk“.

Benzoic acid, Benzo-15-
crown-5

MW
Search Text
(example)

Comment Result (example)

78 to 78.1 Searches the molecular weight by a
user-defined range.

78.0468 (for Benzene and
other C6H6 compounds

Formula
Search Text
(example)

Comment Result (example)

C6H6 Searches for all compounds with exact
six carbons and six protons.

C6H6

C-5H6 Searches for all compounds with # C
<= 5 but exact six protons but an
unlimited number of other hetero
atoms..

C2H6O, C5H6O2

C3-5H6 Searches for all compounds with 3 <=
# C <= 5 but exact six protons.

C3H6, C4H6, C5H6

C3H5Cl Searches for all compounds with exact
three carbons, five protons, one
chlorine atom but an unlimited number
of other hetero atoms.

C3H5ClNO2

C3H5Cl*1 Searches for all compounds with exact
three carbons and five protons, one
chlorine atom and any other atom that
occur one time in a molecule.

C3H5ClO, C3H5ClO

 
 

a) Normal search without wildcard
1. Select the Note Fields …  command of the Search menu. This opens a Note Field

Search dialog with a list of keywords for a search across different databases.



17

2. From the Property column select Compound name and enter the search string
"Benzylchloride" in the Search for edit field.

3. Press the Start button. A connection to the SpecInfo server is established.
4. After a while you receive a hitlist containing a folder which matches your query.

5. The folder contains two 13C NMR spectra and one IR spectrum. The first object is
automatically displayed in the Result area.

 

b) Advanced search using wildcards
1. Select the Note Fields …  command of the Search menu. This opens a Note Field

Search dialog with a list of keywords for a search across different databases.
2. From the Property column select Compound name and enter the search string

"C3H5Cl*1" in the Search for edit field.
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3. Press the Start button. A connection to the SpecInfo server is established.
4. After a while you receive a hitlist containing six folders matching your query. There

are five folders with a formula C3H5ClO and one with C3H5ClS.

The folder contains a structure, two 13C NMR and one 17O NMR peak tables as well
as one IR spectrum.

As you can see the fourth folder has a different formula but machtes your query too.
To retrieve the entry simply click with the mouse pointer to the row and click the left
mouse button. The request is sent to the SpecInfo server. After a few second you
receive the new folder.

 
 

File menu

Import
This command is available as the first one from the File menu. It imports datasets from your
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local file system into SpecSurf. The standard data format for spectra and structures is
JCAMP-DX and additional MDL Molefile for chemical structures. On the File menu click
Import to open a submenu with additional commands. After selecting an import command, a
Browse… /Import dialog opens.

SpecSurf File Transfer Window
Select a Mol file, JCAMP data, or any Peaktable for an upload into SpecSurf. Enter a data file
name in the text box or click the Browse…  button to open a File Upload Box.
Note that the default extension of *.html will of course mean that you will not be shown any
JCAMP-DX files with the extension *.dx. Select from the drow-down menu the option All Files
to see all available data.

In File Name, enter the name of the dataset you want to open. Click OK or double-click on a
file name to select this file without clicking OK.
If the dataset you want to import is not listed, do the following:
� In Look in, select a new drive.
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� In Folders, select a new folder.
� Select a file and click OK.

Click the Transfer button to upload the data into the Java Applet.

SpecInfo Connection Window
 
If you chose JCAMP data, the information from the first row of the query window peak table
will automatically be shown in the Query area of the SpecSurf window.

 
In case of a Mol file, only a structure is displayed.
 
SpecSurf supports the following import formats:
Structures MDL-Mol

JCAMP-CS
Spectra JCAMP Versions

4.24 and 5.0
IR
UV
MS
NMR

 
 
 
Bruker, Varian, Jeol

 

Export
Lets you export a drawn structure located in the structure query area. MOL-File extension is
*.mol, JCAMP-CS is *.cs.
File name Enter the name and the extension of the file you want to

export. You can also change the directory by entering a new
valid path here.

File list Alternatively, you can select a filename from this list.
 If the file which you want to save is not listed, do the
following:
� In Drives, select a new drive.
� In Folders, select a new folder.
� Select a file and click OK.

 

Print
Note: if you want to print the report during a Specsurf session it is necessary to have a
version of the Adobe Reader installed on your system. Otherwise Specsurf will create a PDF
document for a later use.
From the File menu select Print/Report. A second browser window opens with the Specsurf
Report Page.
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The Report Title entry will be the heading of your report. Query structure and spectrum are
displayed on the first page, the search result on the second one and the Hitlist on the third.

Edit menu

Structure
The SpecSurf Structure Editor is a powerful tool to create chemical structures. You can draw
chemical structures with just a few mouse clicks. Written in Java, the Structure Editor is
platform independent.
It's chemical intelligence helps you to draw accurate, chemically significant structures quickly
and intuitively; letters are identified as atoms with valence limits, lines as bonds that attach at
correct lengths and angles. The editor also checks for maximal allowed valences of elements.
Free valences are automatically saturated with Hydrogen; atom charges are considered.
Based on the generated structure and the automatically complemented hydrogen atoms the
empirical formula, the molar or, switchable, the nominal mass are calculated and displayed for
whole molecules, selections, and the corresponding loss. For the nominal mass individual
isotopes are considered.
These are especially interesting features for scientists involved with mass spectroscopy. On
demand, The Structure Editor highlights possible errors and improbable structural features.
 
On the Edit menu, click Structure to start the SpecSurf Structure Editor.
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Structure Editor screen
The central part of the screen contains the so-called workspace where an existing structure
will be displayed or new one can be drawn.
The horizontal toolbar enables access to most of the commands of the File, Edit, Tools, and
Template menu. The vertical toolbox contains most of the drawing tool-buttons. Just click an
icon to perform the respective command.
Using the icons and pop-up menus you can quickly and easily create molecule structures.
Simple mouse-clicks set or move atoms and define bonds. All elements can be entered in
your active structure just by a mouse-click on the respective atom of the displayed periodic
system. Additionally the editor offers a menu from which the mostly used elements can be
chosen directly.
For experienced users, using the keyboard eases the generation and manipulation of
structures; every element of the periodic system as well as any bond and the most common
rings can be activated via the respective keyboard combination.
All structures can be presented with various accompanying information, e.g. the empirical
formula, the atom numbering, charge, carbons, carbon protons are displayed if desired.
Furthermore, you can activate a context dialog, which indicates and allows you to edit the
name, charge, isotope, and weight of the respective atom.
The editor provides different drawing modes, such as Compass Draw, Freehand Draw and
Single Draw. By using the Compass Draw mode for example, you can create molecular
chains of any required length just by dragging the mouse. While dragging the mouse, the
editor displays the number of added atoms.
You can move and rotate complete molecules or selections while bonds are preserved and
adjusted automatically. Various selection modes, e.g. the Lasso Tool, enable you to select
irregularly shaped fragments freehand. The selected fragment can be extended easily.
The editor offers a wide selection of pre-defined ring types. You can select from three-
membered up to nine-membered saturated hydrocarbon rings and Benzene. As well, a rich
set of pre-defined structure templates from various areas of organic chemistry is available.
The user can enter these templates and combine them with/at any chosen bond or atom of
the active structure.
 

Edit Peaklist
SpecSurf contains a built-in peaklist editor, which allows you to create peak spectra of your
own. If there is any spectrum in the query area, the peaks of this spectrum are listed.
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Selecting Edit/Peaklist opens a dialog box with an empty table or the peaklist of the spectrum
located in the query spectrum area. Dependent on the kind of spectrum the dialog should look
similar to this:

Peaklist for a 13C-NMR spectrum
Method Available methods like NMR, UV, IR, …

Note: there is a difference between Full spectrum and Peaklist.
A Full spectrum isn't editable.

Title JCAMP label "Title". This title is displayed in the information
line under the spectrum.

X Unit E.g. ppm, nm (corresponds to the method).
Y Unit Intensity Units corresponding to the method.
With the Peaklist editor it is very easy to create peak spectra manually.

 

Copy to Query area
Copies a structure, spectrum, or folder from the Result area to the respective Query area.
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Search menu

Search Structure

SpecSurf delivers maximum efficiency for structure elucidation and structure identification.
The platform independent SpecInfo client SpecSurf includes the powerful Structure Editor
tool. The Edit/Structure command enables you to define a structure or substructure that is
searched against a structure database. An easy-to-use hitlist displays link hits to the
SpecSurf Result Zone. Select hits by a left mouse-button click.
How to use the Search Structure command
 

Search substructure

Substructure searches are used to retrieve structures containing the drawn part of the
molecule.
Substructure searching means you only want to search for a part of a molecule and you want
to see all chemical structures containing this fragment in your hitlist. The positions where
substitution is allowed in the search fragments are identified by the following wildcards:

a) "?“ (question mark)
A "?“ will be interpreted as „any atom exept hydrogen“.

b) "A“ (any atom)
An "A“ will be interpreted as „any atom including hydrogen“.

 
The number of substructures, including identical ones, is taken into account during the
search. Please note that using small substructures which are common in the database may
lead to long substructure search times.
Search substructure
 

Search Spectrum
Search Spectrum is a spectral search across different databases. The spectrum displayed in
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the Query Spectrum Zone is sent to the server.
Using the Search Spectrum command
 

Search Note Fields
A quick way to find information in SpecInfo is through a Note Fields Search. The Note Fields
Search is a very easy to handle but powerful tool for data retrieval. This function allows you to
search every folder in a database for a particular string. It is different from the object search
because note fields may contain keywords or other data. The Note Fields Search finds only
folders containing the string you are looking for. It uses the predefined fields in the databases
dealing with the most frequently used properties of spectra and structures such as:
� compound name
� formula
� molecular weight.

Using the Search Note Fields command
 

Predict menu

Prediction
An important feature of SpecSurf is the prediction of a spectrum - Database based or Rule
based. SpecSurf allows you to predict spectra for novel or known compounds and use the
predictions to assign peaks.
The following two sections will give you a quick insight on prediction and estimation.
Estimation and prediction differ in algorithms. Estimation gives you the chemical shifts as
results of increment calculations, whereas prediction is calculated on HOSE codes, i.e. the
chemical shift information in the database.
The quality of the spectrum prediction and automatic assignment is dependent on the
contents of a database.
 

Database based prediction
Predicts the X-NMR-spectrum of a structure on the basis of data stored in the database. This
function for each X-atom of the structure searches the database for atoms in a similar
chemical environment, until the predicted spectrum is complete. Because the prediction result
depends strongly on the amount of data stored in a database you have to select a database
from the Select database dialog.
How to use the database based prediction command
 

Rule based prediction
Estimates the 1H- or 13C-NMR-spectrum of a structure on the basis of empirical increment-
systems. Founded on the data of many known 1H- and 13C-NMR-spectra empirical rules for
the absorption of proton or carbon depending on their chemical environment can be stated.
The increment-method supposes that the influence of substituents is additive, which of course
is inexact. Nevertheless, with the exception of structures that show special sterical or
electronical reciprocal action the received values for δ are quite useful.
The estimation process will be started by clicking on the 1H or 13C command.
How to use the rule based prediction command
When pointing with the mouse on an atom, the respective peak is highlighted. When pointing
with the cursor on a peak, the respective atom or atoms is/are highlighted.
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Show menu

Peaklist

Opens a dialog box with the peaklist of the spectrum currently displayed in the Result
spectrum area. Dependent on the kind of spectrum the dialogbox should look similar to this:

Peaklist for a 13C-NMR spectrum
 
Method Lists the corresponding method like NMR, UV, IR…
Title Name of the compound, if available.
X Unit Corresponding to the method like ppm, nm, …
Y Unit Intensity units, corresponding to the method.
All fields are read-only.
 
Note fields contain notices related to the kind of object. That may be for example information
about an experiment or a solvent used during a NMR measurement. These attributes are
stored within the JCAMP-DX or JCAMP-CS data file.

Structure notes
Opens a dialog box with the note fields of the structure currently displayed in the Result
structure area.
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Spectrum
Opens a dialog box with the note fields of the spectrum currently displayed in the Result
spectrum area.

 
Note, that all dialogs are resizable. Move the mouse pointer to the vertical divider. When the
pointer changes to a small double arrow press the left mouse button and hold it down. By
moving the mouse right or left you can change the size of the columns.

 

Float menu
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Float menu
Shows structures, spectra, index, hitlist or the whole application in separate windows.

Float all

The Float all option will detach the Java window from your browser. This allows you to
change the scale of the SpecSurf window to any other than the default size. But note, after
floating all you will loose the browser status information bar which gives you information about
data transfer status. This bar is useful to see if a datatransfer was completed sucessfully or
not.

Clear menu

Clear menu
Clears structures or spectra in the Query or Result area. The clear All command clears
everything inside the SpecSurf working area, including the hitlist.

Settings menu

Settings menu
The Settings menu commands are primary designed to organize the usage of databases.
Additional functionality is given to adapt the online display to the user requirements. The
following commands are available
Databases
Options
Spectrum display
Structure display
Optimize the settings for an optimal handling during a SpecSurf session. But note that
settings are not stored when you leave SpecSurf.
 

Databases
Set Settings/Databases: Searches
Shows all selectable databases for spectrum or structure search. Each database has an ID
and an unequivocal name (External Name). Within this dialog you can define values for
Maximum Number of Hits and Minimum Hit Quality. Change these values with care - a huge
number of hits increases the connection time as well as a small quality value leads to a lot of
unspecified hits.
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Set Settings/Databases: Predictions
Shows selectable databases for spectrum prediction. The more databases are selected the
better is a prediction. No further options are available.
SpecSurf offers the possibility to select several databases at once. The figure shows an
example of how the dialog could look.

To select more than on database use the standard keyboard/mouse combinations: Shift + left
mouse button for sequential selection or Ctrl + left mouse button for a non-sequential
selection.

Options
These command is available as the second one from the Settings menu.

Get First Entry

If the select box is checked the first entry of a hitlist is automatically displayed.

Synchronize Dividers

Synchronizes the movement of the dividers.
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Spectrum display
Shows a checklist with display attributes.
Show Grid Hides or displays gridlines in the spectra.
Hide Status Line Hides or displays the Status Line.
Synchro Zoom X Shows a spectrum in the query as well as in the Result

zone with identical x-axis zoom factors.
Synchro Zoom Y Shows a spectrum in the query as well as in the Result

zone with identical y-axis zoom factors.
A check mark (√) on the left side of the command means the command is active. Click the
command again to remove the check mark and to deactivate the command.
 

Structure display
Shows a checklist with display attributes.
Hide Carbons Hides the carbon element symbol.
Hide Numbers Hides the atom numberings.
Hide Charge Hides charge of a molecule.
Hide Carbon Auto-Protons Hides the protons bonded to the carbon atoms except the

explicitly added protons. Protons bonded to heteroatoms
are always displayed.

Hide All Auto-Protons Hides all protons except the explicitly drawn.
A check mark (√) on the left side of the command means the command is active. Click the
command again to remove the check mark and to deactivate the command.

Help menu

GUI overview
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The Quick Start is designed to illustrate the workspace and to introduce the nomenclature of
the most important working areas.
See the screenshot for further information.

GUI Overview
The Query as well as the Result area is divided into three main parts. Spectra are displayed
on the left side whereas structures are located in the middle. The table on the right contains
additional information about how many and what kind of objects are inside a folder.

The Query area
Imported spectra or structures as well as manually created objects are located in the Query
area. Objects of that area are searched against the selected database(s).

The Result area
Contains the result folder.

The Hitlist
Any successful query, a spectrum search, a property search or a structure search result in a
list of hits – called Hitlist. Listed are by default the sequential numbers, the quality (Ranking)
factors and a descriptor like Title. Of these, the Rank is, perhaps, most interesting, since it
tells you how well your query matches the found database entries. The value of the factor
ranges from 1 to 1000 (best ranking). By default the first entry of a hitlist will automatically
displayed in the Result area. When moving the pointer over a result and pressing the left
mouse button a connection to the SpecInfo server will be established and the content of this
folder will be displayed.
 

The Icon bar
The view of the Icon bar depends on the type of spectrum.

Standard icons (are always available):
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NMR-icons (only NMR spectra):

IR-icon

 
 
 
 


